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1 Introduction 

This document is a Systems Administrator’s Guide for adding, changing, and deleting information to 

Documentation Consultants’  documentation. 

1.1 Purpose 

This Guide will help users modify their documentation, which includes information on the following 
topics: 

 
 Document Properties 
 Title Page 
 Table of Contents 
 Headers and Footers 
 Document Format and Style 
 Page Numbers 

 
Note: This document is not intended as a training guide for either Microsoft Word or Excel. It will assist 
in modification of Microsoft 2007/2010/2013 version documents.  

1.2 Audience 

 
This document is intended for system administrators, analysts, and technical writers who develop and 

modify Documentation Consultants’  documentation. 

1.3 General Form and Template Information 

 
Documentation was prepared using standard template. Certain features and functions apply to all 
documentation where applicable. In the majority of forms, the documents contain the following 
information: 

 Title Page  
 Revision History  
 Copyright Notice and Confidential Statement  
 Table of Contents 
 Glossary of Terms 
 Appendix Section 
 Header and Footer information. 
 Text in Arial font using 11 point size. 
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2 Word 2007/2010/2013 Styles

The vast majority of forms within each package are comprised of Microsoft Word forms and templates.

All of these forms have been developed using cu
below to simplify your customization of these forms.

2.1 Accessing Word’s Styles

To access the styles, place your cursor in the line you wish to change, click on the Home Tab and then 
the Styles Dialog Box Launcher (in the lower right hand corner of the Styles group).

 System Administrator’s Guide

Consultants (www.SDLCforms.com) 

Word 2007/2010/2013 Styles 

The vast majority of forms within each package are comprised of Microsoft Word forms and templates.

All of these forms have been developed using custom Word Styles.  The list of these styles is shown
below to simplify your customization of these forms. 

Accessing Word’s Styles 

To access the styles, place your cursor in the line you wish to change, click on the Home Tab and then 
Launcher (in the lower right hand corner of the Styles group).
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The vast majority of forms within each package are comprised of Microsoft Word forms and templates. 

he list of these styles is shown 

To access the styles, place your cursor in the line you wish to change, click on the Home Tab and then 
Launcher (in the lower right hand corner of the Styles group). 
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2.2 Word Custom Styles 

 

Header Logo 
Header Document Title 

Header Project Name 
Header Version Number 

Company Name 

Document Title 
Document Date 

Copyright Text 

Table of Contents Heading 

Table of Contents Numbered 1 ...............................................................................................  

Table of Contents Numbered 2 ............................................................................................  

Table of Contents Numbered 3 .....................................................................................  

Gray Banner 

1 Heading 1 
1.1 Heading 2 
  1.1.1 Heading  

General Headings 

Body Text No. 1 

Body Text No. 2 

Body Text No. 3 

Body Text Centered 

Body Txt No. 1 Bolded 

1 Body Text Numbered 

 Bulleted No. 1 
o Bulleted No. 2 

 Bulleted No. 3 

Note: 

Blueline Text No Indent 
Blueline Text Left 
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Blueline Text Indent 1 
Blueline Text Indent 2 

  Blueline Text Center 
 Blueline Text Bulleted 1 

o Blueline Text Bulleted 2 
1 1 Blueline Text Numbered 

Table Headings 

Table Text 

Table Text Centered 

Table Text Bolded 

 Table Text Bulleted 

1. Table Text Numbered 

2.  
Footer Confidentiality 

Footer Document Number 

Footer Page Number 

TOC 1 
TOC 2 

TOC 3 

 

2.3 Replacing the Blue Line Text 

The blue line text embedded throughout each form provides instructions and suggested text entries for 
each field on the form. These blue line entries should not appear in your finished document. 

To replace a blue line entry, select the text, and click on the Delete button.  However, the style will 
remain as one of the many blue line text entries available in the Styles library (as shown above). 

You will want to change the style for that entry to one of the styles corresponding to the type of text 
entry you wish to replace it with, by clicking on the appropriate style in the Styles Dialog Box, such as:   

Body Text No. 1 

Body Text No. 2 

Body Text No. 3 

Body Text Centered 

Table Text 

Table Text Centered 

Table Text Bolded 

 Table Text Bulleted 

 

Then type in the new text. 
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3 Word 2003 Maintenance Information 

Note:  Although no longer supported, this section only applies if you are using Word 2003. If you are 
using Word 2007/2010/2013, click here to review the instructions to modify Word 2007/2010/2013 
forms. 

 
The Document Properties area within the Microsoft software contains general information about the 
document. Users should consider changing the Summary tab within the Properties page.  

 
To access the Properties tab, click the following on the Main Menu bar on the top of the page: 

 File and Properties 

 
 

 Enter appropriate line item information within the Summary tab. 
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3.1 Title Page 

 
The Title Page contains initial descriptive document information. Users should change this information 
to the specifics of the document. These items include the following: 

 
 Body of Title Page 

o Company Name 
o Document Title 
o Date 

 Header and Footer Information: 
o Header 

 Company Logo 
 Document Type, e.g., Business Case, System Test Plan 
 Document Title 
 Project or Version Number 

o Footer 
 Confidentiality Statement and proprietary markings (short and long versions) 
 Page Number 

 
Modify Title Page Body Information 

 
Scroll over the respective line and overwrite the appropriate information (use appropriate company font 
and size where applicable): 

 Company Name in Arial bold, 20 point size and centered 
 Document Title in Arial bold, 28 point size and centered 
 Date in Arial bold, 20 point size and centered 

 

YOUR COMPANY NAME 

DOCUMENT TITLE 
DATE 
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 Change Title Page information to black by clicking the font color graphic on the Main Menu bar and 
selecting black. 

 

 

3.2 Header and Footer 

 
Modify Header Information: 

 
To access the Header and Footer tab, click the following on the Main Menu bar on the top of the page: 

 View Header and Footer 

 
 

The System will display the Header information corresponding to the page you are on, e.g.  

  

 
 
 
 
 
 

To move to other header or footer pages, click the respective icon on the graphic. 
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To modify the sample company logo displayed on the title and other pages:  

 Find your company’s logo graphic (in other documents or on your computer) and copy it. 
 Return to your new document, click on the logo located in the header section, and paste your 

company’s logo into the new document. 
 Find all other sample logos by clicking the Show Previous or Show Next graphic on the menu bar to 

move backwards or forward within the document 
 

 
 

 
 

To modify the document type, document title, and project or version number in the header: 

 Move your cursor over each line item and type the respective information. 
 
 

When complete: 

 Close out the Header / Footer graphic bar by clicking the Close icon. 
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or 

 
 Switch to the Footer section to make appropriate changes by clicking the Switch Between Header 

and Footer icon. 
 

 
 

Modify Footer Information: 

To access the Footer tab, click the following on the Main Menu bar on the top of the page: 

 View and Header and Footer 

 
 

 If the Header and Footer graphic is stilled displayed on the page, click the Switch Between Header 
and Footer icon: 

 
 

 
 

To modify the confidentiality statement in the footer: 

 Move your cursor over the statement and type the respective information. 
 

Change the statement information to black by clicking the font color graphic on the Main Menu bar and 
selecting black. 

To modify the page number in the footer: 

 Click the Insert Auto Text dropdown, Header/Footer, and Page X of Y icons. 
 To change the page number in other sections of the document, find them by clicking the Show 

Previous or Show Next graphic on the menu bar and repeat the above procedure. 
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 When complete, close out the Header / Footer graphic bar by clicking the Close icon. 

3.3 Revision History  

 
Update the Revision History Section by entering the respective information. 

 
Date Version Author Change 
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3.4 Copyright Notice 

 
Update the Copyright Notice Section by changing the respective information. 

 
Example: 

 
 

COPYRIGHT NOTICE 
Copyright © 2016 Documentation Consultants. 

All rights reserved.  These materials are for internal use only.  No part of these materials may be 
reproduced, published in any form or by any means, electronic or mechanical, including photocopy or any 

information storage or retrieval system, nor may the materials be disclosed to third parties without the written 
authorization of Documentation Consultants. 

 

3.5 Table of Contents 

 
 To create the Table of Contents, click the following on the Main Menu bar on the top of the page: 

Insert, Reference, and Index and Tables. 
 

 
 
 
 
 

 Click the Table of Contents tab. 
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 Select the format from the From Template drop-down box. 
 Select the number of levels from the Show Levels drop-down box. 
 Click the OK box when finished. 

 
Example: 

 

 
 

 To update the Table of Contents, click the contents of the Table of Contents and the following 
display box will appear. 
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 Click the Update entire table radio box, and then press the OK box when finished. 
 

 

3.6 Glossary 

 
Update the Glossary Section table (if applicable) by entering the respective information. 
 
Example: 
 

Topic Description 

Ad-hoc Testing This type of testing is done without any formal Test Plan or Test Case creation. Ad-hoc 
testing helps in deciding the scope and duration of the various other testing and it also 
helps testers in learning the application prior starting with any other testing. 

Enhancement The addition of new functionality and/or the change/removal of existing functionality in 
order to improve the application. 

Functional Testing In this type of testing, the software is tested for the functional requirements. The tests 
are written in order to check if the application behaves as expected.  

Incident A problem with the application, test script, tester performance and/or documentation, 
which prevents verification of a particular requirement or design element. 

Regression 
Testing 

The process of re-executing one or more test scripts in order to verify that errors have 
been properly corrected and that no new errors have been introduced. 



 
 System Administrator’s Guide 

Version 3.10 
 

 

Confidential – ©2014 Documentation Consultants (www.SDLCforms.com) 

 

Page 18 of 40 

 

3.7 Appendix 

This section contains information that is important to the document, e.g., diagrams, graphics, and 
special information.  The following table provides information that may be helpful in preparing the 
document and performing its quality assurance.  

 
Topic Description and Quality Assurance Suggestion 

Document Properties Click ‘File’ and ‘Properties’: Contains title, subject, author, and company. 

Track Changes Special side bar characters on pages to denote changes, if applicable. All 
tracked changes are finalized and special side bar indicators, underlines, 
colors, etc. must not be displayed unless requested by the client. 

Title Page  Title, date, logo, names (company, preparer, and recipient names),  

copyright notice, confidential statement and proprietary marking. 

Table of Contents Numbered and aligned correctly, no bookmark errors, displays appropriate 
number of heading levels, and page numbers. 

Headers and Footers  Logo, date, page number, confidentiality statement, and proprietary markings 
on all pages. 

Heading and Section Titles  Correctly titled, numbered, and aligned with correct size and font. 

Spell and Grammar Check  Note: not all recommended changes should be implemented. 

Document content  Content is technically correct, consistent, complete, and is easily understood. 

Document Format and 
Style 

Consistent within the document and with similar documentation. 

All requested and required 
information is contained 
within the document  

Headings, sections, client data, expenses, equipment, explanations, letters, 
and attachments, etc. 

Acronyms  Acronyms are always spelled out first. 

Appendices  Referenced in the document and correctly numbered with appropriate content. 

Contact Information  Correct name, address, telephone, cell, email, and fax. 

Cross-References  Item referenced correctly with appropriate content. 

Date and Time  Correct content and consistent format. 

Footnotes  Numbered, linked, and placed correctly. 

Format Consistent size, shape, spacing, color, alignment, indentation (bullets, 
numbers, and outlining), lines, fonts, bolding, italicizing, underlines, borders, 
shading, word casing (sentence, upper, lower, title), background, fill, and line 
breaks. 

Glossary and Definitions Listed alphabetically or by topic and contains accurate information. 

Graphics Includes information to introduce the graphic (correct content, size, placement, 
and is easily understood). 

Hyper-links  Recognized as a link if online-size, color, underlined, and goes to the correct 
location when keyed. 
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Topic Description and Quality Assurance Suggestion 

Index  Listed alphabetically or by topic with correct sub levels and page numbers. 

Organizational Charts  Easy to read, names and titles correct, in the right reporting order, and linked to 
the appropriate area or management. 

Page and Section Breaks  Appropriately placed, not too much white space on page, and keeps whole 
chapters, sections, and content together. 

Page Numbers  Correctly numbered and displayed in a consistent matter. 

Process and Workflow 
Charts 

Easy to read, activity flows in a consistent order, correct activity content-uses 
appropriate boxes, circles, arrows, pointers, links, connections, markings, and 
end points. No missing or confusing steps. 

Quotes and References  Content correct and displayed appropriately. 

Special Characters  Used correctly and contains beginning and end marks, e.g., parentheses and 
brackets. 

Symbols  Used and placed correctly. 

Table of Figures  Referenced in the document and correctly numbered with appropriate content. 

Tables and Charts  Contains an introductory sentence, easy to read, correct content, size, spacing, 
sorting, alignment, placement, correct row table headings and displays on each 
continuing page, and rows are allowed to break across pages when specified. 

Terminology  Correct usage for topic, used consistently, and can be understood. 
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4 Word 2007/2010 Maintenance Information 

The Document Properties area within the Microsoft software contains general information about the 
document. Users should consider changing the Summary tab within the Properties page.  

4.1 Updating the Document Summary Information 

 Click on the File menu and then the Properties hyperlink (on right side of window), and then select 
Advanced Properties to display the Properties dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on the Summary tab. 
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 Enter appropriate information within the Summary tab. 
 

4.2 Modifying the Title Page 

The Title Page contains initial descriptive document information. Users should change this information 
to the specifics of the document. These items include the following: 

 
 Body of Title Page 

o Company Name 
o Document Title 
o Date 

 Header and Footer Information: 
o Header 

 Company Logo 
 Document Type, e.g., Business Case, System Test Plan 
 Document Title 
 Project or Version Number 

o Footer 
 Confidentiality Statement and proprietary markings (short and long versions) 
 Page Number 

 
 

 

 

 

 

The various data elements comprising the page are shown in Figure 1-1. 
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HEADER 

 
 
TITLE PAGE BODY 

 
FOOTER 

 

 
Figure 1-1.  Title Page Data Elements 

4.2.1 Modify Header Detail 

 
To access the Header, click on the Insert Menu and then the Header icon in the Main Menu bar on the 
top of the page: 

 
 
 
 
 
 
 
 
 
 
 
 

A dropdown menu will appear. Click on the Edit Header icon.  The document header will appear 
highlighted for you to make changes. 
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Modify the Company Logo 

To replace the default company logo, click on the logo to highlight the graphic, and then click on the 
Picture icon.  The Insert Picture dialog box will display.  Navigate to the location of your company logo 
and click on the Insert button to insert your logo.  Use the handles on the graphic to size the graphic to 
the desired shape and size. 

Note:  Since the majority of SDLCforms have multiple sections, you may need to repeat this process in 
every section in the document. 

 
Modify the Project Name 

On the right hand side of the header, highlight the Project Name text and replace it with your project 
name. 

 
Modify Version 

Below the Project Name, highlight the Version text and enter the version number of the document 
(generally Version 1.0). 

When you are complete with all changes, click on the Close Header and Footer icon to return to the title 
page. 
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4.2.2 Modify Title Page Body Information

 
Scroll over the respective line and overwrite the appropriate informatio
applicable): 

 Replace “Your Company Name
 Replace “Date” with today’s date.

 
 
 
 

 
 

4.2.3 M
o
d
i 

4.2.4 Modifying the Footer Detail

To access the Footer, click on the 
top of the page: 

 
 
 
 
 
 

A dropdown menu will appear. Click on the 
to make changes. 

 

 

 

To modify the confidentiality statement in the footer:

 Move your cursor over the statement and type the respective information.
 While the confidentiality statement is highlighted, chan

clicking into the statement and when the popup menu appears, click on the “A” icon to change the 
color. 

 Note that the representative 
to scan the entire document for additional sections, as most of 
sections due to differences in the first page layout and subsequent pages.
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Modify Title Page Body Information 

Scroll over the respective line and overwrite the appropriate information (use appropriate style 

Company Name” with your company name. 
with today’s date. 

er Detail 

on the Insert Menu and then the Footer icon in the Main Menu bar

A dropdown menu will appear. Click on the Edit Footer icon.  The footer will appear highlighted for you 

To modify the confidentiality statement in the footer: 

Move your cursor over the statement and type the respective information. 
While the confidentiality statement is highlighted, change the statement information to black by 

into the statement and when the popup menu appears, click on the “A” icon to change the 

illustration above only applies to Section 1 of the footer.  You will need 
the entire document for additional sections, as most of the SDLCforms have multiple 

sections due to differences in the first page layout and subsequent pages. 
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Main Menu bar on the 

icon.  The footer will appear highlighted for you 

ge the statement information to black by 
into the statement and when the popup menu appears, click on the “A” icon to change the 

illustration above only applies to Section 1 of the footer.  You will need 
SDLCforms have multiple 
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To modify the page number in the footer: 

 Click on the Page Number icon in the Insert menu. 
 A dropdown menu will display.  Click on Format Page Numbers.  The Page Number Format dialog 

will display. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can make any changes to the page numbering scheme you desire. 

 
When you are complete with all changes, click on the Close Header and Footer icon to return to the title 
page. 
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4.3 Revision History  

 
Update the Revision History Section by entering the respective information. 

 
Date Version Author Change 

    

    

 

4.4 Copyright Notice 

 
Update the Copyright Notice Section by changing the respective information. 

 
Example: 

 
 

COPYRIGHT NOTICE 
Copyright © 2016 Documentation Consultants. 

All rights reserved.  These materials are for internal use only.  No part of these materials may be 
reproduced, published in any form or by any means, electronic or mechanical, including photocopy or any 

information storage or retrieval system, nor may the materials be disclosed to third parties without the written 
authorization of Documentation Consultants. 

 
 

4.5 Table of Contents 

 
To create or update the Table of Contents, click on the References tab on the Main Menu bar on the 
top of the page:  

The click on the Table of Contents icon on the left hand side of the Main Menu bar.  
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The Table of Contents dialog will display. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Example: 

 

 
 
 
 

To update the Table of Contents, right click the contents of the Table of Contents and then Update 
Field in the dropdown menu that displays  
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The following display box will appear. 

 

 
 

Click the Update entire table radio box, and then press the OK box to complete the effort. 

4.6 Glossary 

 
Update the Glossary Section table (if applicable) by entering the respective information. 

 
Example: 

 
Topic Description 

Ad-hoc Testing This type of testing is done without any formal Test Plan or Test Case creation. Ad-hoc 
testing helps in deciding the scope and duration of the various other testing and it also 
helps testers in learning the application prior starting with any other testing. 

Enhancement The addition of new functionality and/or the change/removal of existing functionality in 
order to improve the application. 

Functional Testing In this type of testing, the software is tested for the functional requirements. The tests 
are written in order to check if the application behaves as expected.  

Incident A problem with the application, test script, tester performance and/or documentation, 
which prevents verification of a particular requirement or design element. 

Regression 
Testing 

The process of re-executing one or more test scripts in order to verify that errors have 
been properly corrected and that no new errors have been introduced. 
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4.7 Appendix 

This section contains information that is important to the document, e.g., diagrams, graphics, and 
special information.  The following table provides information that may be helpful in preparing the 
document and performing its quality assurance.  

 
Topic Description and Quality Assurance Suggestion 

Document Properties Click ‘File’ and ‘Properties’: Contains title, subject, author, and company. 

Track Changes Special side bar characters on pages to denote changes, if applicable. All 
tracked changes are finalized and special side bar indicators, underlines, 
colors, etc. must not be displayed unless requested by the client. 

Title Page  Title, date, logo, names (company, preparer, and recipient names),  

copyright notice, confidential statement and proprietary marking. 

Table of Contents Numbered and aligned correctly, no bookmark errors, displays appropriate 
number of heading levels, and page numbers. 

Headers and Footers  Logo, date, page number, confidentiality statement, and proprietary markings 
on all pages. 

Heading and Section Titles  Correctly titled, numbered, and aligned with correct size and font. 

Spell and Grammar Check  Note: not all recommended changes should be implemented. 

Document content  Content is technically correct, consistent, complete, and is easily understood. 

Document Format and 
Style 

Consistent within the document and with similar documentation. 

All requested and required 
information is contained 
within the document  

Headings, sections, client data, expenses, equipment, explanations, letters, 
and attachments, etc. 

Acronyms  Acronyms are always spelled out first. 

Appendices  Referenced in the document and correctly numbered with appropriate content. 

Contact Information  Correct name, address, telephone, cell, email, and fax. 

Cross-References  Item referenced correctly with appropriate content. 

Date and Time  Correct content and consistent format. 

Footnotes  Numbered, linked, and placed correctly. 

Format Consistent size, shape, spacing, color, alignment, indentation (bullets, 
numbers, and outlining), lines, fonts, bolding, italicizing, underlines, borders, 
shading, word casing (sentence, upper, lower, title), background, fill, and line 
breaks. 

Glossary and Definitions Listed alphabetically or by topic and contains accurate information. 

Graphics Includes information to introduce the graphic (correct content, size, placement, 
and is easily understood). 
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Topic Description and Quality Assurance Suggestion 

Hyper-links  Recognized as a link if online-size, color, underlined, and goes to the correct 
location when keyed. 

Index  Listed alphabetically or by topic with correct sub levels and page numbers. 

Organizational Charts  Easy to read, names and titles correct, in the right reporting order, and linked to 
the appropriate area or management. 

Page and Section Breaks  Appropriately placed, not too much white space on page, and keeps whole 
chapters, sections, and content together. 

Page Numbers  Correctly numbered and displayed in a consistent matter. 

Process and Workflow 
Charts 

Easy to read, activity flows in a consistent order, correct activity content-uses 
appropriate boxes, circles, arrows, pointers, links, connections, markings, and 
end points. No missing or confusing steps. 

Quotes and References  Content correct and displayed appropriately. 

Special Characters  Used correctly and contains beginning and end marks, e.g., parentheses and 
brackets. 

Symbols  Used and placed correctly. 

Table of Figures  Referenced in the document and correctly numbered with appropriate content. 

Tables and Charts  Contains an introductory sentence, easy to read, correct content, size, spacing, 
sorting, alignment, placement, correct row table headings and displays on each 
continuing page, and rows are allowed to break across pages when specified. 

Terminology  Correct usage for topic, used consistently, and can be understood. 
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5 Word 2013 Maintenance Information 

The Document Properties area within the Microsoft software contains general information about the 
document. Users should consider changing the Summary tab within the Properties page.  

5.1 Updating the Document Summary Information 

 Click on the File menu and then Prepare and then Properties, to display the Document Properties 
dialog box. 

 

 
 

 Enter appropriate information within the Document Properties tab, including replacing the Author, 
entering the Subject and optionally entering the Category and Status. 

 

5.2 Modifying the Title Page 

The Title Page contains initial descriptive document information. Users should change this information 
to the specifics of the document. These items include the following: 

 
 Body of Title Page 

o Company Name 
o Document Title 
o Date 

 Header and Footer Information: 
o Header 

 Company Logo 
 Document Type, e.g., Business Case, System Test Plan 
 Document Title 
 Project or Version Number 

o Footer 
 Confidentiality Statement and proprietary markings (short and long versions) 
 Page Number 
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The various data elements comprising the page are shown in Figure 1-1. 

 

 

HEADER 

 
 
TITLE PAGE BODY 

 
FOOTER 

 

 
Figure 1-1.  Title Page Data Elements 

5.2.1 Modify Header Detail 

 
To access the Header, click on the Insert Menu and then the Header icon in the Main Menu bar on the 
top of the page: 

 
 
 
 
 

A dropdown menu will appear. Click on the Edit Header icon.  The document header will appear 
highlighted for you to make changes. 

 
 
 
 
 
 

M
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odify the Company Logo 

To replace the default company logo, click on the logo to highlight the graphic, and then click on the 
Picture icon.  The Insert Picture dialog box will display.  Navigate to the location of your company logo 
and click on the Insert button to insert your logo.  Use the handles on the graphic to size the graphic to 
the desired shape and size. 

Note:  Since the majority of SDLCforms have multiple sections, you may need to repeat this process in 
every section in the document by copying the embedded (resized) graphic into the header of each 
section. 

 
Modify the Project Name 

On the right hand side of the header, highlight the Project Name text and replace it with the current 
project name. 

 
Modify Version 

Below the Project Name, highlight the Version text and enter the version number of the document 
(generally Version 1.0). 

When you are complete with all changes, click on the Close Header and Footer icon to return to the title 
page. 
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5.2.2 Modify Title Page Body Information

 
Scroll over the respective line and overwrite the appropriate information (use appropriate style where 
applicable): 

 Replace “Your Company Name
 Replace “Date” with today’s date.

 
 
 
 

 
 

5.2.3 M
o
d
i 

5.2.4 Modifying the Footer Detail

To access the Footer, click on the 
top of the page: 

 
 
 
 
 
 

A dropdown menu will appear. Click on the 
to make changes. 

 

To modify the confidentiality statement in the footer:

 Move your cursor over the statement and type the respective information.
 While the confidentiality statement is highlighted, change the statement information to black by 

clicking into the statement and when the
color. 

 Note that the representative illustration above only applies to Section 1 of the footer.  You will need 
to scan the entire document for additional sections, as most of the SDLCforms have multi
sections due to differences in the first page layout and subsequent pages.
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Modify Title Page Body Information 

espective line and overwrite the appropriate information (use appropriate style where 

Your Company Name” with your company name. 
” with today’s date. 

Modifying the Footer Detail 

To access the Footer, click on the Insert Menu and then the Footer icon in the Main Menu bar

A dropdown menu will appear. Click on the Edit Footer icon.  The footer will appear highlighted for you 

the confidentiality statement in the footer: 

Move your cursor over the statement and type the respective information. 
While the confidentiality statement is highlighted, change the statement information to black by 
clicking into the statement and when the popup menu appears, click on the “A” icon to change the 

Note that the representative illustration above only applies to Section 1 of the footer.  You will need 
to scan the entire document for additional sections, as most of the SDLCforms have multi
sections due to differences in the first page layout and subsequent pages. 
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icon.  The footer will appear highlighted for you 

 

While the confidentiality statement is highlighted, change the statement information to black by 
popup menu appears, click on the “A” icon to change the 

Note that the representative illustration above only applies to Section 1 of the footer.  You will need 
to scan the entire document for additional sections, as most of the SDLCforms have multiple 
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To modify the page number in the footer: 

 Click on the Page Number icon in the Insert menu. 
 A dropdown menu will display.  Click on “Format Page Numbers.”  The Page Number Format dialog 

will display. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can make any changes to the page numbering scheme you desire. 

 
When you are complete with all changes, click on the Close Header and Footer icon to return to the title 
page. 
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5.3 Revision History  

 
Update the Revision History Section by entering the respective information. 

 
Date Version Author Change 

    

    

 

5.4 Copyright Notice 

 
Update the Copyright Notice Section by changing the respective information. 

 
Example: 

 
 

COPYRIGHT NOTICE 
Copyright © 2016 Documentation Consultants. 

All rights reserved.  These materials are for internal use only.  No part of these materials may be 
reproduced, published in any form or by any means, electronic or mechanical, including photocopy or any 

information storage or retrieval system, nor may the materials be disclosed to third parties without the written 
authorization of Documentation Consultants. 

 
 

5.5 Table of Contents 

 
To create or update the Table of Contents, click on the References tab on the Main Menu bar on the 
top of the page:  

The click on the Table of Contents icon on the left hand side of the Main Menu bar. Scroll down to and 
click on “Insert Table of Contents.” 

 
 
 
 
 
 
 
 
 



 
 System Administrator’s Guide 

Version 3.10 
 

 

Confidential – ©2014 Documentation Consultants (www.SDLCforms.com) 

 

Page 37 of 40 

 

 
The Table of Contents dialog will display. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Example: 
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To update the Table of Contents, right click the contents of the Table of Contents and then Update 
Field in the dropdown menu that displays  

 
The following display box will appear. 

 

 
 

Click on the Yes button to complete the effort. 

5.6 Glossary 

 
Update the Glossary Section table (if applicable) by entering the respective information. 

 
Example: 

 
Topic Description 

Ad-hoc Testing This type of testing is done without any formal Test Plan or Test Case creation. Ad-hoc 
testing helps in deciding the scope and duration of the various other testing and it also 
helps testers in learning the application prior starting with any other testing. 

Enhancement The addition of new functionality and/or the change/removal of existing functionality in 
order to improve the application. 

Functional Testing In this type of testing, the software is tested for the functional requirements. The tests 
are written in order to check if the application behaves as expected.  

Incident A problem with the application, test script, tester performance and/or documentation, 
which prevents verification of a particular requirement or design element. 

Regression 
Testing 

The process of re-executing one or more test scripts in order to verify that errors have 
been properly corrected and that no new errors have been introduced. 
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5.7 Appendix 

This section contains information that is important to the document, e.g., diagrams, graphics, and 
special information.  The following table provides information that may be helpful in preparing the 
document and performing its quality assurance.  

 
Topic Description and Quality Assurance Suggestion 

Document Properties Click ‘File’ and ‘Properties’: Contains title, subject, author, and company. 

Track Changes Special side bar characters on pages to denote changes, if applicable. All 
tracked changes are finalized and special side bar indicators, underlines, 
colors, etc. must not be displayed unless requested by the client. 

Title Page  Title, date, logo, names (company, preparer, and recipient names),  

copyright notice, confidential statement and proprietary marking. 

Table of Contents Numbered and aligned correctly, no bookmark errors, displays appropriate 
number of heading levels, and page numbers. 

Headers and Footers  Logo, date, page number, confidentiality statement, and proprietary markings 
on all pages. 

Heading and Section Titles  Correctly titled, numbered, and aligned with correct size and font. 

Spell and Grammar Check  Note: not all recommended changes should be implemented. 

Document content  Content is technically correct, consistent, complete, and is easily understood. 

Document Format and 
Style 

Consistent within the document and with similar documentation. 

All requested and required 
information is contained 
within the document  

Headings, sections, client data, expenses, equipment, explanations, letters, 
and attachments, etc. 

Acronyms  Acronyms are always spelled out first. 

Appendices  Referenced in the document and correctly numbered with appropriate content. 

Contact Information  Correct name, address, telephone, cell, email, and fax. 

Cross-References  Item referenced correctly with appropriate content. 

Date and Time  Correct content and consistent format. 

Footnotes  Numbered, linked, and placed correctly. 

Format Consistent size, shape, spacing, color, alignment, indentation (bullets, 
numbers, and outlining), lines, fonts, bolding, italicizing, underlines, borders, 
shading, word casing (sentence, upper, lower, title), background, fill, and line 
breaks. 

Glossary and Definitions Listed alphabetically or by topic and contains accurate information. 

Graphics Includes information to introduce the graphic (correct content, size, placement, 
and is easily understood). 
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Topic Description and Quality Assurance Suggestion 

Hyper-links  Recognized as a link if online-size, color, underlined, and goes to the correct 
location when keyed. 

Index  Listed alphabetically or by topic with correct sub levels and page numbers. 

Organizational Charts  Easy to read, names and titles correct, in the right reporting order, and linked to 
the appropriate area or management. 

Page and Section Breaks  Appropriately placed, not too much white space on page, and keeps whole 
chapters, sections, and content together. 

Page Numbers  Correctly numbered and displayed in a consistent matter. 

Process and Workflow 
Charts 

Easy to read, activity flows in a consistent order, correct activity content-uses 
appropriate boxes, circles, arrows, pointers, links, connections, markings, and 
end points. No missing or confusing steps. 

Quotes and References  Content correct and displayed appropriately. 

Special Characters  Used correctly and contains beginning and end marks, e.g., parentheses and 
brackets. 

Symbols  Used and placed correctly. 

Table of Figures  Referenced in the document and correctly numbered with appropriate content. 

Tables and Charts  Contains an introductory sentence, easy to read, correct content, size, spacing, 
sorting, alignment, placement, correct row table headings and displays on each 
continuing page, and rows are allowed to break across pages when specified. 

Terminology  Correct usage for topic, used consistently, and can be understood. 
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